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1 About Chromasens 

The name of our company, Chromasens, is a combination of 'Chroma' which means color, and 
'Sens' which stands for sensor technology. 
 
Chromasens designs, develops and produces high-quality and user-friendly products:  
 
◼ Color line scan cameras  

◼ 3D stereo line scan cameras 

◼ Multi-spectral line scan cameras 

◼ Camera systems  

◼ Camera illumination systems 

◼ Image acquisition systems  

◼ Image processing solutions 

Today, Chromasens GmbH is experiencing steady growth and is continually penetrating new 
sales markets around the globe. The company's technologies are used, for example, in 
products and for applications such as book and document scanners, sorting systems and 
inspection systems for quality assurance monitoring.  

Customers from all over the world of a wide range of industrial sectors have placed their trust 
in the experience of Chromasens in the field of industrial image processing. 

1.1 Contact Information 

Chromasens GmbH 

Max-Stromeyer-Str. 116 

78467 Konstanz 

Germany 

Phone: +49 (0) 7531 / 876-0 

Fax: +49 (0) 7531 / 876-303 

Email: info@chromasens.de 

1.2 Support 

Chromasens GmbH 

Max-Stromeyer-Str. 116 

78467 Konstanz 

Germany 

Telephone: +49 (0) 7531 / 876-500 

Fax: +49 (0) 7531 / 876-303 

Email: support@chromasens.de 

 

Visit our website at http://www.chromasens.de for detailed information on our company and 
products. 

mailto:info@chromasens.de
mailto:support@chromasens.de
http://www.chromasens.de/
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2 General Information 

The Chromasens CS-3D-Viewer is a C# program that uses the CS-3D-API to calculate 3D 
information from the captured image(s). The CS-3D-API calculates a rectified RGB/BGR/gray-
image, a 16-bit height map image and optionally a point cloud of the corresponding 3D model. 

The Chromasens CS-3D-API and the Chromasens CS-3D-Viewer use the OpenCV library 
(which can be downloaded from https://opencv.org) for image processing. The license of the 
OpenCV library is included in the “…/Chromasens/3D/docs”-folder. 

2.1 Software Requirements 

• System 

o Windows 7, 8.1, 10 64-bit 

• NVidia Driver Version 441.87 or newer 

• Software protection dongle drivers 

• For sample code only: 

o Development Environment 

▪ Microsoft Visual Studios 2010 

▪ MFC 

o OpenCV – Library v2.4  

2.2 Hardware Requirements 

• CUDA 3.0 capable GPU hardware with at least 3 GB RAM (see chapter 2.3) 

• Quad Core i7 > 2.4 GHz 

• RAM >= 16 GB  

• Power-supply with enough power for the GPU(s) 

• Software protection dongle 

2.3 Compatible GPU 

In general, every 3.0 CUDA capable GPU can be used. The following GPUs were tested for 
their compatibility: 

 

Not compatible: 

o NVidia GTX 285 

o NVidia GTX 480 

o NVidia GTX 580 

 
Compatibility tested: 

o NVidia GTX 680 

o NVidia GTX 770 

o NVidia GTX 780 TI 

o NVidia GTX 980 

o NVidia GTX 980 TI 

o NVidia GTX Titan 

https://opencv.org/
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o NVidia GTX 1060 

o NVidia GTX 1080 

o NVidia RTX 2070 

2.4 Recommended System 

• Software 

o Windows 10 x64 

 

• Hardware 

o NVidia GTX Card with 4 GB RAM 

o Intel i7 3.2 GHz 

o 16 GB RAM 

o Software protection dongle  

o Chromasens 3DPIXA stereo camera system 
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3 Getting started 

3.1 Acquire a Sharp and Well Illuminated Image 

Firstly, you need to acquire a good image which can be used for the 3D-calculation. This may 
take up most of your time of 3D imaging. Use the Viewer only, if you have made sure, your 
image is sharp and well illuminated.  

Follow the instructions below: 

• Setup your 3DPIXA to the correct operating condition (refer to the 3DPIXA-Getting 
Started). 

• If you take care of the following issues, the 3D calculation accuracy can be increased: 

o The image should be sharp. Please place the object in focus and check the pixels. 

o Example of a blurred and a sharp image 

                        ✔ 

                    Blurred      Sharp 

o The image should have as less shadow and as less glossy areas as possible. Please 
pay attention to the brightness of the illumination.  

 
After having the correct camera setting, raw image(s) can be acquired for 3D calculation. The 
acquisition can be done for instance by using the program shipped with the frame grabber you 
are using. 

Please make sure your raw image(s) have the correct format and size (chapter 5.2.1). 

*You may use sample images provided to get familiar with the 3D-Viewer (chapter 6.13.2). 

3.2 Using the Viewer 

After acquiring a sharp and well illuminated raw image (chapter 3.1), please continue with the 
following steps: 

• Check the system requirements. 

• Install the CS-3D software (chapter 4) 

• Plug the USB dongle into a USB-slot of your computer. 

• Launch the 3D-Viewer 

• Load the correct configuration file (chapter 6.2). 

• Load and calculate your raw image(s) (chapter 6.3). 

When the calculation completes, you will get the preliminary 3D calculation results. 

• Adjust the system parameters (chapter 6.5) to obtain the best 3D images according to 
your needs.  

o The object height profile is calculated and shown in the height map image based 
on your configured system parameters. 

Congratulations, you have just created a 3D image with highly precise height calculation with 
your 3DPIXA system. 
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*Furthermore, you may export the calculated 3D images and load them into the viewer in 
another time for instance for the purpose of demonstration (chapter 6.10). 
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4 Installing the 3D-Viewer 

For operating the 3D-Viewer, please make sure you have installed the current NVidia driver 
according to the defined system requirements. 

 

Double click the “cs-3d-setup-vX.XX.exe” icon and choose the installation language. 

 

               

 

   cs-3d-setup-vX.XX.exe 

From cs-3d-setup-v2.3e (and newer), the installer will also install Chromasens-Software-
Manager together with the 3D-Viewer. This enables the 3D-Viewer to check for updates and 
download the newest version automatically, and also enables to keep other software products 
of Chromasens uptodate. 

 

Follow the setup wizard to install the 3DPIXA-software package after installing Chromasens-
Software-Manager. You may select the desired directory in which the 3DPIXA-software 
package should be installed. You may also choose which components of the 3DPIXA-software 
package you would like to install. 

 

The software package includes the following: 

• CS-3D-API 

o USB-Dongle driver 

o Dlls 

o Header files 

o C++, C# and HALCON Examples  

• 3D-Viewer 

• Example images 

• Documentation and Manuals 

• HALCON Extension 12, 13 or 18.11 

o Please choose the corresponding extension version during the installalation. 

You can later change the version by reinstallation. 
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5 CS-3D-Viewer  

The Chromasens 3D-Viewer can help you to evaluate your images acquired with the 3DPIXA.  

  

  

5.1 Online Mode and Offline Mode 

Online mode: 

3D-data can be calculated based on the system parameters (chapter 6.5). A direct visual 
feedback is obtained after the calculation of the images.  

A valid license (USB dongle) and a CUDA 3.0 enabled GPU are required to use the 3D-
Viewer in Online mode. 

Offline mode: 

In offline mode, raw images cannot be loaded into the 3D-Viewer and 3D data cannot be 
calculated. You may load pre-computed data into the 3D-Viewer (chapter 6.10.2) in order 
to show the pre-computed 3D-data for the purpose of demonstration. 

5.2 Image Formats 

5.2.1 Raw Images 

Image requirements: 

• 8 bit, 24 bit and 32 bit images - png, bmp, gif format 

• Image height: dependent of the available amount of RAM of the PC and the GPU. 
Calculation of images with larger image height results a larger RAM usage  

• Image width: depends on the camera configuration and calibration 

• Amount of raw images needed for 3D calculation 

o 1 raw image for the 3DPIXA - compact housing 

o 2 raw images for the 3DPIXA - dual housing 

Please refer to chapter 6.3 for how to load raw image(s) into the viewer. 

Raw images may be acquired by a frame grabber specific program.  

 

5.2.2 Output Images 

The 3D-Viewer calculates the 3D-data and outputs the following images if the corresponding 
options are enabled in configuration: 

• Rectified image (24-bit png format) 

Menu bar 

Displays modes (chapter 5.4) 
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The rectified image is the corrected image based on the raw images. It is corrected so 
the height map image perfectly fits on the rectified image. Also the distortion is 
removed. 

• Height map image (16-bit gray-value tiff format) 

The height map image includes the height information of the scanned object. Pixels 
with larger grayscale values in the height map image are higher than those with 
smaller values. The grayToMm() function that is documented in the CS-3D-Api manual 
can be used to convert the pixel values to the height in mm. 

The height map image is calculated with subpixel accuracy and is scaled to 16-bit 
value range within the selected height range (from lower height range limit to upper 
height range limit). Zero value indicates that no height information is present (chapter 
6.5.1). 

• Confidence map image (32-bit gray-value dat format) 

The output of confidence map is optional. By default the confidence map won’t be 
calculated and displayed. To activate the confidence map, the parameter 
doCalcConfMap has to be set to 1 in the configuration file, or the option “Calculate 
Confidence Map” in the tab page “Advanced Parameters” of calculation options has to 
be enabled. Confidence map provides a measure of the likelihood at each pixel 
position of the height calculation to be correct. Larger value (brighter area) in the 
confidence map indicates that the corresponding height calculation in the height map 
and point cloud is more confident, and vice versa.   

• 3D-Point cloud (Chromasens specific cs3d format) 

The 3D-Point cloud consists of a binary list of points with X, Y and Z coordinates. The 
X, Y and Z coordinates of all points are stored in a 1-D float array with one float per 
coordinate. The order of the coordinates is X0Y0Z0X1Y1Z1X2Y2Z2X3Y3Z3… There is not 
a delimiter between the points and between the coordinates. The unit is millimeter. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure: the coordinate system of a 3d point cloud from Chromasens 
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The diagram above shows the point cloud coordinate system. X axis corresponds to 
point position in mm along sensor direction, y axis corresponds to point position in mm 
in scanning direction, and z axis corresponds to distance in mm from object surface to 
the free working distance plane. The origin (0, 0, 0) is placed in the middle between 
both lenses in the free working distance to the camera. The points in the left part of 
the image have negative X coordinates, and in the right part they have positive values. 
In the upper part they have positive Y coordinates and in the lower part they have 
negative ones. The Z coordinates further away than the free working distance from the 
camera are negative, and the ones closer are positive. 

 

5.3 Export Point Cloud as Other Formats 

You may export the 3D-point cloud information and the height map image as csv-file (e.g. for 
importing into Excel). Please refer to chapter 6.11.1 for how to export these information. 

Furthermore, the 3D point cloud can also be exported as STL file (chapter 6.11.2) or VRML file 
(chapter 6.11.3), which can be viewed or processed in other 3D tools. 

 

5.4  Display Modes 

The 3D-Viewer offers five display options: 

• 3D Model: A plot showing the height profile of the object. 3D-Point cloud can be 
shown in this plot. 

• Height Map Image: An intensity image showing the calculated 3D height profile. 
Brighter areas are higher than darker areas (see chapter 6.5.1 for further information). 
To display these gray values, they are reduced to 256 gray levels. 

• Rectified Image(A): The corrected image from master camera which fits to the height 
map image. 

• Rectified Image(B): The corrected image from slave camera. 

• Confidence Map: By default the confidence map won’t be calculated and displayed. 
To activate the confidence map, the parameter doCalcConfMap has to be set to 1 in 
the configuration file or the option “Calculate Confidence Map” in the tab page 
“Advanced Parameters” from the menu “Calculation” → “Options” has to be enabled 

• Raw Image: The acquired image without processing.  

Please refer to chapter 6.6 to see how to operate the 3D-Viewer in the different displays. 

On the left side of the 3D-Viewer, the following information can be found: 

• Height map image:  

o 16-bit intensity values are displayed (0-65535). 

o The pixel value can be converted to the distance to the camera. 

o If a pseudo-color ROI (region of interest) is selected, then the relative height 
difference between the current point and the mean height of the pseudo-color 
ROI is displayed. 

• Rectified image: The R, G and B intensity values are displayed (8 bit: 0-255). 

• ROI information (chapter 6.12) 
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6 Using the Viewer 

6.1 Opening 3D-Viewer 

The 3D-Viewer can be used in Online and Offline mode (chapter 5.1).  

A valid license (USB dongle) and a CUDA 3.0 enabled GPU with current driver are required to 
use the 3D-Viewer in Online mode. 

Double click the “CS-3D-Viewer” icon to open the 3D-Viewer. 

                         

                                                

Note: 3D-data (including 3D height map image) cannot be calculated in offline mode. Pre-
computed data can be still loaded into the 3D-Viewer and the 3D-data can be shown. This can 
be done for demonstrations purposes for example. 

6.2 Loading and Saving a Configuration File 

6.2.1 Loading a Configuration from File  

There are two options to load a configuration from file. 

Option 1: Click the menu bar “File”, then click “Load config file” and choose “from file” 

 

 

After selecting a configuration file in the following window and clicking the button “open”, the 
file will be loaded and applied. 

 

Option 2: On the menu bar, click “Calculation” and select “Options” to open the configuration 
window. 
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In the configuration window, click “Settings” on the menu bar, select “Load config” and 
then “from file” to load the correct configuration file to the 3D-Viewer.

 

Select the configuration file “config.ini”  or a previous saved “xxx_cfg.ini”, then click the “Apply” 
button of the configuration window 

 

If an error occurs when loading the configuration file, please refer to chapter 7.2 for possible 
solutions. Or some parameters (chapter 6.5) are not set correctly in the given configuration 
file. 

First time loading the configuration file:  

The configuration file can be found in the folder “CalibrationFile” of the USB stick provided. 
Please copy and paste both files “config.ini” and “calibration.ini” to a desired folder before 
loading the configuration file. 

6.2.2 Loading a Configuration from Camera 

A configuration can also be loaded from the camera. Clicking the menu bar “File” → “Load 
config” → “from camera”, 

 

Or clicking the menu bar “Calculation” → “Options” → “Settings” → “Load” → “from camera”, 
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By starting to load configuration from camera, all the currently available ports are listed. You 
can choose one port, and click the button “LoadConfig from Camera”, to load the configuration 
from the camera from the chosen port. 

If you are not sure, which cameras are currently connected to which port, you can click the 
button “Search connected Cameras” to detect them. The detection will last for a while. After 
that, the connected cameras will be shown. This helps to find a connected camera more 
easily. By default, the search option “Camera Link” is activated. If you want to detect additional 
cameras, which are connected with RS232, you can also enable the search option “RS232”.  
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NOTE Please pay attention that all the other tools which establish camera connections, 
such as Camera Setup Tool (CST), have to be closed before running the 
detection here. Otherwise, the camera cannot be detected because the 
connection is already in use. 

 

After executing “Load Config from Camera”, the program will inform you the result. It can be 
“successful” or a code which indicates the error. Only newer 3DPIXA cameras have the 
configuration and the calibration stored within the camera.  

6.2.3 Saving a Configuration to File  

After modifying the system parameters (chapter 6.5), you may save the current configuration 
by opening menu bar “Calculation” -> “Options” and then choosing “Save config” → “to file” 
under “Settings”.  

There are three possiblities to save the configuration locally on computer. 

• “to current config file”: The config file, which is loaded, will be overwritten. 

• “to default config file on this PC”: A configuration file and a calibration file are 
overwirtten in the directory: C:\Users\Public\Documents\Chromasens\3D\viewer 
settings. At the next start of 3D-Viewer, the default config will be loaded from there 
(chapter 7.2). 

• “as…” the configuration and its corresponding calibration file can be saved anywhere 
else in a certain folder. 
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NOTE The configuration file accesses information stored in the calibration file 
“calibration.ini”. It is therefore important that the directory stated in the 
configuration file is correct. Please refer to chapter 7.2 for more information. 

                    

6.2.4 Saving a Configuration File to the Camera 

Simliar to Loading a configuration from the camera, you can also write the configuration into 
the camera. The saving process can be started by clicking menu bar “Calculation” → “Options” 
→ “Settings” → “Save config” → “to camera”. The button “Save Config To Camera” executes 
the saving process and copy the current configuration into the camera, which is connected to 
the chosen port. 
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6.3 Loading (and Calculate) Raw Images 

Please make sure you have loaded the correct configuration file before loading your raw 
image(s) (chapter 6.2).  

 

On the menu bar, click “File”, point on “Load raw file(s)” then  

 

For 3DPIXA - compact housing: 

• click “Single raw image”  

• load the raw image 

 

 

For 3DPIXA - dual housing: 

• click “Two raw images”  

• load XXX_A.png/bmp/gif and 
XXX_B.png/bmp/gif subsequently

  

You may directly calculate the 3D height map based on the configuration file loaded. The 3D 
data then is directly calculated. Choose “Load and calculate” then

 

For 3DPIXA - compact housing: 

• click “Single raw image” 

• load the raw image 

 

 

For 3DPIXA - dual housing: 

• click “Two raw images” 

• load XXX_A.png/bmp/gif and 
XXX_B.png/bmp/gif subsequently

  

 

Depending on the number of cameras in the current loaded config file, the appropriate option 
“Single raw iamges” or “Two raw images” can be selected and the other one will be 
deactivated accordingly. 
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NOTE The calculation of an image with a very large image height can result in a big 
consumption of CPU and GPU memory. In this case the user will receive a 
warning message about the possible memory shortage after loading a raw image. 
Then he can decide whether he wants to continue or cancel the calculation. 

  

6.4 Load Mask Image (Optional) 

In most cases, we calculated the height information of the whole image. But if we are only 
interested in certain areas on the image, then we can create a mask image, load it into the 3D-
Viewer. If the mask is enabled, the calculation will only occur on the areas of the mask image, 
where the grayscale is not zero. 

 

Attributes of a mask image: 

1) Can be an RGB or grayscale image 

2) Has exactly the same image size as the height map result. 

3) If a mask image is enabled, black-areas (color value [0, 0, 0] of an RGB, or 0 of an 
grayscale) of the mask image will not be considered for the calculation. Only non-black 
areas have height information. 

 

A mask image can only be loaded when the raw image is already loaded. To calculate the 
image with a mask, please click menu “File” → “Image Mask” →”Load Image Mask and 
Calculate” to choose a mask image from PC. Then mask image will be displayed in the 
tabpage “Mask Image”, and be used for the calculation 

 

 

If the mask should be disabled for the next calculation, please click “Enable Mask” to uncheck 
it. To enable the mask, “Enable Mask” should be checked again. 
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Figure: image mask

Figure: height image with image mask  

 

6.5 Adjust Configuration Parameters 

After loading the calibration file and your acquired raw images, you may evaluate your images 
and re-calculate the 3D-data after adjusting the system configuration parameters. 

On the menu bar, click “Calculation” and select “Options” to open the configuration window. 
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   Figure:  Configuration window 

6.5.1 Height Range Limit 

  

The height range indirectly defines the camera distance range which is applied to calculate 
your 3D data. The lower value of the selected height range (namely height range start) should 
correspond to the lowest point of your object and the upper value (namely height range end) to 
the highest point of your object. It is suggested to start with a big range, and then reduce to 
the smallest possible height range that includes the structures you would like to analyze. 
Height information between height range start and height range end is represented by 16-bit 
data, leading to a highly accurate 3D height calculation. It is also possible to use the “Height 
Range Wizard” to find the suitable upper and lower height range limit.   
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Figure: Height range limit 

 

The height range can be set either with the option “Height Range” or “Distance to 0 Plane” 

• Height Range [unit: pixel]: Each camera has its own free working distance, where the 
sharpest image of the scanned object should be normally acquired. The plane, on which 
the object has the free working distance to camera, is also called the 0 plane. The height 
range is based on this relative pixel shift of an image point between the left and right 
rectified image. The valid interval of this parameter depends on the height range defined 
in the calibration. 

• Distance to 0 Plane [unit: mm]: Here you may change the height range in the unit mm 
according to this 0 plane. The both ranges can be converted into each other. The valid 
interval of this parameter depends on the height range which is described above. 
Additionally, the range of absolute distance to the camera in unit millimeter will be also 
shown below, which provides situationally an obvious impression of the used distance 
range in the reality.  

• An object point at the 3DPIXA’s working distance plane / zero-plane has a shift of zero 
pixel between the both images.  

• An object point below the working distance plane (further from the camera) has a negative 
shift in pixel between both images / is in the negative part of the height range and has a 
negative distance to 0 plane. 

• An object point above the working distance plane has a positive shift in pixel between both 
images / is in the positive part of the height range and has a positive distance to 0 plane. 

 

The 16-bit height map image is scaled between the chosen height range start and height 
range end. The intensity value of the height map correlates to the height of the object. Pixel 
value 1 and 65535 of a height map correspond the given height range start and height range 
end. Value 0 indicates that the height information is not available. For conversion from the 
intesity values to height information in millimeter, please refer to the 3D-API manual. 
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6.5.2 Height Range Wizard 

The choice of height range affects the height map result. The height range wizard can provide 
the preview of height map if the height range is changed. The wizard can be started by clicking 
the button “Height Range Wizard”, The configuration file and the raw images have to have 
been loaded already. 

 

In upper area of the wizard, the user can adjust the lower height range limit (dStart) and upper 
height range limit (dEnd) by moving the scrollbars. The preview of rectified image and of 
height map will be changed accordingly.  

 

If one area on the object is out of the height range, then this area will be displayed as black in 
height map preview, In preview of rectified image, this area will be marked as red (if it is above 
the upper height range limit) or green (if it is below the lower height range limit). So it is 
possible to adjust the height range to get an appropriate height map. 
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6.5.3 General Parameters 

 

6.5.3.1 Gray Value Range 

This parameter specifies the minimum and the maximum pixel intensity value that are used for 
the 3D data calculation. Very dark and bright pixels of shadow and gloss areas outside the 
given gray value range are excluded for the calculation, because these points do not have 
enough contrast for correlation. The valid value of this parameter can be set to [0, 255]. 

6.5.3.2 Color Channels 

You may choose to use all the color channels, or only one channel (blue, green or red) for 
calculating the 3D data. 

6.5.4 Parameter of Semi Global Matching 

There are two matching methods to calculate the height information. To change the 
parameters of semi global matching, please enable “Use SGM (Semi Global Matching)” in 
“Matching Method Parameters” first. 
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6.5.4.1 Fixed Height Range 

Default value is unchecked, which means dynamic height range is used.  

User can choose between fixed height range or flexible height range. With fixed height 
range, the maximum height search range is 128 pixels. If the input height range (dEnd-
dStart) is larger than 128, dEnd is ignored. With flexible height range, any height range is 
accepted for calculation, and dStart and dEnd are used for calculating the height range.  

6.5.4.2 P1 and P2 

P1: constant penalty value for small disparity change (i.e. 1 pixel). Using a lower penalty for 
small changes permits an adaptation to slanted or curved surfaces. P1 is in range between 0 
and 31. Default value is 7.  

P2: constant penalty for all larger disparity changes (i.e. larger than 1 pixel). It preserves 
discontinuities. Discontinuities are often visible as intensity changes. It has always to be 
ensured that p2 > p1. p2 is in range between 0 and 127. Default value is 100.  
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6.5.5 Refinement Parameters of Block Matching 

 

To change the refinement parameters of block matching, please einable “Use Block Matching” 
in “Matching Methode”. The refinement parameters and their influence will be introduced 
below. 

6.5.5.1 Correlation Window Size 

              

The size of the pattern window is adjustable by a parameter. The larger the window size, the 
better the stability and reliability of the correlation results. Furthermore, the height accuracy 
increases with window size. If you want to see fine details of the object, then we recommend 
smaller window sizes. As a trade-off, more unrelated points may be correlated, which will lead 
to false calculations 

 

            Figure:Influence of correlation window size 

• The window size defines the size of the neighborhood area of the pixels that is used to 
find pixel correspondance from one image to another. 

• A larger window is better for objects with less textures.  

• A smaller window takes fine texture structures more into account, is however a bit more 
noise-sensitive . 

 

Smaller window 

Consideration of fine textures 

 e.g. edges 

Larger window 

Robustness against errors 
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Figure: Window size 3x3 sharper edges, but more points without information (“black holes”) 

   

Figure: Window size 27x27, smooth edges, closed surface 

. 

6.5.5.2 Minimum Correlation Factor 

The “Minimum Correlation Factor” can be set between 0.00 and 1.00. 

• With small factors, weak correlating structures are accepted, and the accuracy may not be 
as high as with larger factors, but a closed height map can be generated. 

• With large factors, only strong correlating structures are accepted, resulting in higher 
accuracy of the calculation, but areas with weak correlation under the given threshold will 
not be taken into account and have therefore no height information. 

The higher the “Minimum Correlation Factor” is, the more confident a computed height is. 
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            Left: Height image with a correlation factor 0.9.   Right: with a correlation factor 0.3 

6.5.5.3 Left/Right Consistency 

The correlation is working in both ways. Points from the left image will be matched to the right 
image and points from the right image will be matched to the left image. So in total we have for 
one object (image) point two correlation results. The left/right consistency value specifies 
maximum accepted difference (in pixel unit) between left-right matching result and right-left 
matching result. A lower value leads to more reliable measurements. This parameter can be 
set between 0 and 100. 

6.5.5.4 Minimum Contrast 

With this function you can define the acceptable level of contrast for the 3D data calculation.  

The numerical range is from 0.00 to 255.00. For example, 10.00 means you accept 3D 
calculation results with mean intensity difference larger than 10.00 between the pixels within 
the correlation window. In the resulting data the areas with a lower contrast than the minimum 
contrast are marked out. 0.00 means all contrast levels are used for the 3D data calculation. 
Using a very low contrast level may lead to not so accurate results in areas of less contrast. 

6.5.6 Visualization Parameters 

You can find these parameters by clicking the menu bar “Calculation” → “Options”→ tab page 
“Visualization Parameters” 

 

6.5.6.1 Correction Plane  

If your object is tilted, you may enable this function. By enabling this function, the viewer 
creates a virtual plane and calculates the 3D height of the object based on the created plane. 
This function is used for the pseudo-color image. The default value of this parameter is 
“disabled / not selected”. 
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6.5.6.2 Outlier Exclusion 

With this setting, you may set the percentage of pixels to be marked as potential outliers. The 
valid range minimum can be set between 0.0% and 30.0% and the default value is 0.0%. The 
valid range maximum can be set between 70.0% and 100.0% and the default value is 100.0%. 
If we sort all the valid height values in a pseudo-color map from small to big and put them in a 
queue (assuming that there are N valid height values in this queue), then the smallest 
(N*minimum% points at beginning of the sorted queue) and the biggest height values 
(N*maximum% points at end of the sorted queue) will be marked as black in pseudo-color 
map. Other values in-between will be retained and displayed as normal. This could be used to 
mark out some noice areas such as peaks or valleys on a height map, because such areas 

often have extremely high or low height values.     

 

Left: retain 0.5% - 99.5%               Right: retain 3.0%-97.0% 

6.5.6.3 Point Cloud Resolution 

With this setting, you can set the sampling rate for the 3D-model computation and display. The 
default value is 1/10, which means 1 out of 10 points are selected to be computed and 
displayed. The finest resolution is achieved when the 3D resolution is set to 1/1, where every 
point is displayed in the 3D-model. However this could lead to a large amount of data to be 
displayed. So please be careful of the large data, when the resolution is going to be set to 1/1. 

            

 Figure: 3D resolution 1/10: Every 10 points are sampled 
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 Figure: Point cloud resolution 1/2:  Every two points are sampled 

 

6.5.6.4 Smoothing  

With this function enabled, the results of the 3D-calculation will be smoothed. This will make 
the results look nicer, but also increases the calculation time. The default value of this 
parameter is “disabled / not selected”. 

         

Left: 3D model without smoothing       Right: 3D model with smoothing 

 

6.5.6.5 Absolute Coordinates 

When this option is enabled, the 3D-object is shown with absolute x and y coordinates 
(chapter 5.2.2). Otherwise, the origin coordinate (0, 0) is set to (xmin, ymin) of the object. The 
z coordinates are not affected in both situations. 

 

Even by restarting the 3D-Viewer, almost all the parameters in tab page “Visualization 
Parameters” will use their previous settings. Please check these parameters if you want to 
change the visualization. 

6.5.7 Advanced Parameters 

The following parameters are listed in the tab page “Advanced Parameters”. 
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6.5.7.1 Calculate 3D Point Cloud 

The default value of this parameter is “enabled / selected”. In a configuration file, this 
corresponds to doCalc3DPoints=1 by default. This can be disabled if the 3D calculation or 
display is not necessary.(In current beta version, 3d point cloud calculation is not supported if 
semi global matching is enabled) 

6.5.7.2 Calculate Height Map 

The height map provides the height information in 16bit (and displays it as a 8 bit grayscale 
image in the viewer). The areas, which are closer to camera, have a larger height, and will be 
displayed as brighter regions on a height map. The areas which are further away to camera, 
have a lower smaller height, and will be displayed as darker regions. In a configuration file, 
this corresponds to doCalcHeightImage=1 by default. If it is disabled, then the point cloud and 
confidence map, which are based on height map, will be disabled too. For general use of 3D-
Viewer, it is strongly recommended to keep height map and rectified image enabled. 

6.5.7.3 Calculate Rectified Image(A) 

The rectified image provides a preprocessed image of camera A, in which the camera 
distortions are rectified. The default value of this parameter is “enabled / selected”. This 
corresponds to doCalcRectifiedImage=1 by default in a configuration file. The rectified image 
will be used as a texture to render the point cloud, so if the calculation or display of point cloud 
is activated, then it is also recommended to enable rectified image,  

 

6.5.7.4 Calculate Rectified Image(B) 

The rectified image provides a preprocessed image of camera B, in which the camera 
distortions are rectified. The default value of this parameter is “disabled / unselected”. This 
corresponds to doCalcRectifiedImageB =0 by default in a configuration file.  
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6.5.7.5 Calculate Confidence Map 

The confidence map provides a visualization of reliability of the height information of each 
pixel. The brighter areas in a confidence map have a higher correlation value and thus the 
height information there is more confident. The default value of this parameter is “disabled 
/unselected”. In a configuration file, this corresponds to doCalcConfMap=0 by default. In order 
to calculate and display the confidence map, this option needs to be enabled / selected in the 
3D-Viewer. (In current beta version, confidence map calculation is not supported if semi global 
matching is enabled) 

 

 

6.5.7.6 Enable Central View 

Since version v2.3 of 3D-Viewer, the user can enable or disable central view directly in the 3D-
Viewer. The following diagram shows the difference of rectified result image with 
disabled/enabled central view feature. The default value of this parameter is „disabled“, and 
corresponds to enableCombinedView=0 in configuration file. This means, the generated 
rectified image and height image are based on the viewing angle of one camera, which leads 
to perspective distortion. If this option is enabled (which corresponds to enableCombinedView 
=1 in configuration file), then the viewing angle of both cameras will be considered and the 
perspective distortion will be corrected. This feature is only available for calibration version 2.1 
or newer. (For calibration version, please refer to camera information in 6.5.8) (In current beta 
version, central view calculation is not supported if semi global matching is enabled) 
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If “high accuracy range“ is enabled, the 
height range is limited to a region where 
the accuracy is best. 

If “high accuracy range“ is disabled, a 
wider height range limit can be used for  
3d calculation. 

 

6.5.7.7 Limit to High Accuracy Range 

The default value of this parameter is “enabled”. In a configuration file, this corresponds to 
enableHeightRangeLimit=1. 

There are two kinds of height range limits (chapter 6.5.1).  

 

 

 

 

 

 

 

 

 

 

Rectified / height image 

Without perspective 
correction / central view 

With perspective correction / 
central view 

Rectified / height image  

Physical setup 

3DPIXA 

Physical setup 

3DPIXA 
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If this option is enabled: The height range limit which can be applied for very accurate 
measurements, will be used, If the chosen height range start and height range end are set 
within this limit, then a highly reliable calculation result can be expected.  

If this option is disabled: A wider height range limit is allowed for the calculation. If the height 
range start and height range end are set within this limit, but outside the high accuracy range 
limit, which is mentioned above, then the calculation could be less accurate. 

6.5.7.8 Scan Direction 

The default value of scan direction is “Forward”, which means the objects are scanned forward 
in respect of the camera. The user has the possibility to change the scan direction to 
“backward” if the calibration of the camera is v2.0 or newer. This can be applied directly for 
objects which are scanned backwards. 

The forward scan direction is defined as following:  

                                                             

Top view: 3DPIXA compact                               Top view: 3DPIXA dual 

 

NOTE This feature is only available for cameras with calibration file of version 2.0 or 
newer. 

The option “Scan Direction” will be deactivated in 3D-Viewer for cameras which 
have an older version of calibration. 

If the scan direction is changed to “Backward”, also the scan direction of the 
camera setting has to be adjusted using the CST-software or the CS-API. 

 

6.5.7.9 Timeout 

The timeout given in seconds limits the time available to calculate the 3D-data. A timeout can 
be hit if the image is very large or the used GPU has less computing power. In that case 
increasing the timeout is an option. The default value for timeout in Chromasens 3D-Viewer is 
40 sec. The timeout can be set from 40 to 200.   

6.5.8 Camera Information 

In the tab page “Info”, the information of the camera will be shown. 
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Sensor: compact housing, or dual housing. 

Image Height: the height of the image which is currently loaded. If no image is loaded, the 
height will be obtained from the configuration file. 

Image Width: the width of the image. 

Resolution x: the resolution in lateral direction. 

Resolution y: the resolution in scan direction. 

Serial Number: each camera has its own serial number for identification 

Type: the product type, which the camera belongs to. 

Calibration Version: The version of calibration. 

Calibration Date: The date shows when the camera was originally calibrated. 

6.5.9 Automatically Check for Updates 

 

This option can be found in the tab page “Info”. Its default value is “enabled / selected”. If 
enabled, 3D-Viewer will check for updates from the server once per day. Similar to the 
manually check for update (6.13.8), the automatic check will be executed daily and inform the 
user, only if there is a newer version available. (Internet connection has to be available.) 

 

6.6 Performance Measurement Tool 

The 3D-Viewer has a built-in tool for performance measurements that can be accessed 
through the menu of the main window: 
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Like all 3D calculations it requires both a configuration and input image(s) for running the 
performance tests. The performance test will use the configuration and image data that was 
loaded for the previous calculation. In case no configuration or no image data has been 
loaded, this can be done directly from the “Performance Test” dialog by selecting the “Load 
Configuration…” (2) and “Load Images(s)…” (3) buttons. There is also an “Options…” (4) 
button that allows changing parts of the configuration and directly restart performance tests 
without closing the dialog.  

 

 

 

A performance test should be executed with enough iterations (e.g. 25) which can be specified 
in the “Number of iterations” field (1). The test can be start from the “Run Performance Test” 
(5) button and canceled with the “Close” / “Cancel” (6) button at any time. A progress bar will 
be shown to indicate the progress and the results will be displayed in the text fields of the 
“Results” (7) section. The performance test result shows the throughput in lines per second.  

 

6.7 Operating the 3D-Viewer - Mouse and Keyboard Controls 

6.7.1 3D Model 

Mouse controls: 

• Rotation: Left mouse button pressed down 

• Panning: Middle mouse button pressed down 

• Zoom in and out: Scrolling the mouse wheel or right mouse button pressed down 

Keyboard controls: 

• Rotation around the X-axis: Insert / Delete 

• Rotation around the Y-axis: Home / End 

• Rotation around the Z-axis: Page up / Page down 

• Panning: Cursor keys 

• Zoom in and Zoom out:  +  /  - 

• Reset zoom and position: “R” 

• Spread the height: Shift-key + Scrolling middle mouse wheel 

To make small height differences better visible, the Z-value of the 3D points can be 
multiplied by a factor. This factor is increased / decreased by using the mouse wheel. 

1 

2 3 4 

5 6 

7 
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3D mouse controls: 

Currently support is the 3D-Connexion SpaceNavigator 

The movement of the object is very intuitiv, e.g. pull the button in your direction to zoom in 
at the object.  

Reset zoom and position: Click the right-mouse button.  

 

6.7.2 Height Map Image / Rectified Image 

Mouse control: 

• Show pseudo-color image: Left mouse button pressed down and drawing of a 
rectangle (chapter 6.7.3). 

o By showing an area in pseudo-color image, the 3D model also shows the 
pseudo-color image. 

• Zoom in rectangle area: Right mouse button pressed down and drawing of a 
rectangle 

• Reset image: Middle mouse button or keyboard “r”. 

6.7.3 Pseudo-color Image 

Press down the left mouse button in the rectified or the height map image and draw a 
rectangle to specifiy the rectangle for the pseudo-color image.  

 

There are two types of pseudo-color image. 

• Default:  

The default pseudo-color image scales pseudo-color between the lower and the upper 
height range limit within the selected rectangle. The free working distance plane in the 
selection is displayed as 0 mm. 

• Correction plane (can be used, if your object is tilted to the 3DPIXA camera):  

A plane is fitted through all the height values. A scanned object which lies tilted to the 
3DPIXA camera within the 3D space is then fitted to the new plane. The pseudo-color 
view shows the height values relatively to the new fitted plane. The height in mm is 
displayed relatively to that plane. The heights in the selection below the plan are displayed 
as negative values, the values above as positiv values. 

Activate the correction plane via “Calculations→Options” and checking the “Use 
Correction Plane” check box at the “Configuration window”.  

 

  

 

6.8 View Images in 3D-Viewer 

The raw images, their height map image and rectified image can be viewed in CS3D-Viewer.  

6.8.1 Zoom ROI 

Press down the right mouse button and draw a rectangle to specifiy the rectangle for the 
region of interest of one image in CS3D-Viewer. If you are interested in a particular region of 
the image, you can zoom at it. 

6.8.2 Scroll within a Zoomed ROI 

If the image is zoomed to ROI, then the ROI can be scrolled horizontally and vertically with the 
scrollbars. 
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6.8.3 Reset ROI 

Press “r” or the middle mouse button to reset the zoom of the height map image and the 
rectified image.  

 

Please notice that the height map image, the rectified image and confidence map share the 
same ROI, but raw image A and raw image B have their own ROI.  

 

Operation on Zoom  Scroll  Reset  

Height map image  

ROI of rectified 
image, height 
map image and 
confidence map 
will be refreshed 
simultaneously. 

 

ROI of rectified 
image, height map 
image and 
confidence map will 
be refreshed 
simultaneously. 

 

ROI of rectified 
image, height map 
image and 
confidence map will 
be reset 
simultaneously. 

Rectified 
image(A/B) 

Confidence map 

(if activated) 

Raw image A Only its own ROI 
will be changed 

Only its own ROI will 
be changed 

Both raw image A 
and B will be reset 

 Raw image B Only its own ROI 
will be changed 

Only its own ROI will 
be changed 

 

6.8.4 Reset View of 3D model 

If the 3D model was rotated or moved from its origin, you can click the middle mouse 
button or the “r” key on the keyboard to reset this view back to origin, but the already 
selected ROI in 3D model view won’t be reset. 
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6.9 Calculating 3D-Data 

Please make sure that you have your raw image(s) and corresponding configuration file 
loaded (chapter 6.2 and 6.3)  

On the menu bar, click “Calculation” and select “Do 3D Calculation” 

 

 

You may modify the system parameters before 3D-calculations. Please refer to chapter 6.5. 

6.10 Loading and Saving Image Data Package  

6.10.1 Saving Calculated Image-Data Package 

On the menu bar, click “File” and select “Save calculated image-data package”.  

               

6.10.1.1 Saving Components of Calculated Image-Data Package Separately 

The following components will be saved in the chosen directory (XXX is the specified file-
name) if *.cs3d format is chosen. 

             

The newly saved configuration file “XXX_cfg.ini” accesses the information stored in the 
calibration file “calibration.ini” located in the same directory. It is therefore important that when 
changing the location of the configuration file, the calibration file has to be moved to the same 
locations as the configuration file. 

Generated file in 
the data package 

Filename Format 

Raw image(s) Single camera system: 
XXX_AB.png  

Dual camera system: 
XXX_A.png, 
XXX_B.png  

 

PNG, can be opened with standard image 
viewer tool 
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Mask image (if 
enabled) 

XXX_Mask.png PNG, can be opened with standard image 
viewer tool 

Height map image XXX_height.tiff TIFF (16 bit zip compressed TIFF), can be 
opened with standard image viewer tool. 

Pixel(N) Pixel(N+1) … 

unsigned short unsigned short … 
 

Rectified image(A) XXX_tex.png PNG, can be opened with any image viewer 
tool 

Rectified image(B) XXX_texB.png 

3D point cloud XXX_p3d.cs3d CS3D (Each pixel is presented by x-, y- and z-
coordinate. Data type: float), can be only 
displayed with CS-3D-Viewer. 

Pixel(N) Pixel(N+1) … 

x y z x y z  

float float float float float float … 
 

Confidence map (if 
activated) 

XXX_confmap.dat DAT, can be only displayed with CS-3D-
Viewer. 

Pixel(N) Pixel(N+1) … 

float float … 
 

Configuration file XXX_cfg.ini INI, can be opened with standard text editor 
tool 

Calibration file calibration.ini INI, can be opened with standard text editor 
tool 

6.10.1.2 Saving Components of Calculated Image-Data Package in one file 

Different from above, if *.ccs3d is chosen as the save format, then all the components will be 
saved in one file, which can also be loaded into viewer later. 

             

 

6.10.2 Loading Precomputed Image-Data Package: 

User can load the image data which was saved with the “Save calculated image-data” function 
of the viewer before.  
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6.10.2.1 Loading Precomputed Image-Data Package from a Chromasens 3d File (*.cs3d) 

  

 

Choose the XXX_p3d.cs3d file. 

The files saved (chapter6.10.1.1) must be located in the same folder as the XXX_p3d.cs3d 
file. 

(XXX is the given file name.) By choosing a cs3d file from the file dialog, all the components 
which belongs to this 3d package can be located and then loaded. Because this method loads 
cs3d file, so the point cloud file must exist. 

6.10.2.2 Loading Precomputed Image-Data Package from a Compressed File (*.ccs3d) 

Another possibility is to load the whole 3d data package from a compressed file. This file can 
be generated from chapter 6.10.1.2, which contains all necessary components. They will be 
uncompressed and then displayed in 3D-viewer. 

 

 

6.11 Export Point Cloud  

6.11.1 Export Point Cloud as CSV-File 

You may save a region of interest as a CSV-File. Press down the right mouse button and draw 
a rectangle of the ROI. If no ROI is drawn, the whole image is selected. On the menu bar, click 
“File”, point on “Export” and select which file you would like to export. 

• Export height map ROI as CSV: 

You can save the chosen ROI as a csv-file that includes the height in mm for each pixel. The 
first row holds the X and Y position followed by the width and the height of the ROI. The data 
follows one row for each line of the ROI. Invalid points are saved as 0. 
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After saving the csv-file, you can open it (for example with Excel) to check the data of pixel 
value from the height map image.  

 

• Export 3D-point cloud ROI as CSV 

You can save the X, Y and Z positions of an ROI of the point cloud to file. The first row 
holds the X and Y position followed by the width and the height of the ROI. Then each 
following row consists of the X. Y and Z coordinate of one point, which has valid height 
value. The coordinates of points with no height information won’t be exported. 

 

 

                    

6.11.2 Export Point Cloud ROI as STL File 

The x, y, z-coordinates of the whole point cloud, or part of the point cloud, can be exported as 
a STL (stereo lithography)-file, which can be opened in other tools for further processing. 
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If the point cloud data is available (either after 3d calculation or after loading a precomputed 
dataset), by clicking “File” → “Export” → “3D-point cloud as STL file”, the following option 
window will be shown. 

  
You can set the upper left and bottom right corners to define a region by yourself, in which the 
data will be exported. The ROI size will be changed correspondingly depending on the 
coordinates. The default region is the predefined ROI (which is defined by dragging & clicking 
right mouse). Otherwise, the default region is the whole image size (width * height) 
The sample distance defines the density of the sample points in the point cloud. By default it is 
set to 10, which means, every 10th point will be sampled in horizontal and vertical direction. If 
the sample distance is set to 1, then every point will be used which can cause a high memory 
and disk usage. 
By clicking the button “Export” you can choose a file name where the result is saved to. If the 
checkbox “Compress STL in a zip file” is activated, a compressed zip file that includes the STL 
file will be generated. 

6.11.3 Export Point Cloud as VRML File 

Similar to export the point cloud data as a STL file, the point cloud can be also exported as a 
VRML (virtual reality model language)-file, together with its texture file (.PNG-file in this case) 
for further processing. 
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If the point cloud data is available (either after 3d calculation or after loading a precomputed 
dataset), by clicking “File” → “Export” → “3D-point cloud as VRML file”, the following option 
window will be shown. 

 
 
You can set the upper left and bottom right corners to define a region by yourself, in which the 
data will be exported. The ROI size will be changed depending on the coordinates. The default 
region is the predefined ROI (which is defined by dragging & clicking right mouse). Otherwise, 
the default region is the whole image size (width * height) 
The sample distance defines the density of the sample points in the point cloud. By default it is 
set to 10, which means, every 10th point will be sampled in horizontal and vertical direction. If 
the sample distance is set to 1, then every point will be used which can cause a high memory 
and disk usage. 
By clicking the button “Export” you can choose a file name where the result is saved to. If the 
checkbox “Compress VRML in a zip file” is activated, then a compressed zip file will be 
generated, which contains the VRML file (*.wrl) and the texture file (*.png). 
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6.12 View ROI Info / Pixel Info 

At the bottom left corner of the 3D-viewer the information about the image ROI, pseudo-color 
ROI, and the mean distance from the pseudo-color ROI to camera is shown. If no ROI is 
selected, the size of the full image instead of the size of ROI will be shown.  

 

 

 

 

 

 

When moving the mouse over the image, the info of the pixel value will be shown in the status 
bar. 

 

Mouse moving 
over 

Height 
Map Image 

Rectified 
Image 

Confidence 
Map 

Raw 
Image 
A/B 

3D-
Model 
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current image 
coordinates 

yes yes yes yes no 

distance of current 
point to camera 

yes yes yes no no 

Distance difference 
compared with mean 
pseudo color ROI 

yes if ROI 
exists 

yes if ROI 
exists 

yes if ROI 
exists 

no no 

Further information 
of current point 

Grayscale 
value of 
height 

Grayscale 
value of 
height, 
RGB 

confidence 
value 

RGB RGB 

 

6.13 Other Functions 

6.13.1 Other Menu Bar Functions 

The 3D model shows a closed-surface view. You may switch to the point-cloud representation 
without visualizing the texture by choosing “View” at the menu bar and enabling “Show point 
cloud”. 

 

 

Under “View”, you have also the possibility to display the “no value”-points in red. 

By clicking “Info” at the menu bar, you can open the manual of 3D-Viewer, or the manual of 
3D-Api, or your version of the 3D-Viewer is displayed. 

 

 

6.13.2 Sample Images and Sample Precomputed Data 

To get familiar with the 3D-Viewer, test images are provided. You may find them in the 
application directory. 

In Windows 7, with default installation presets, the sample images can be found in the 
following directory:  

C:\Users\Public\Documents\Chromasens\3D\sample images\single camera system 

C:\Users\Public\Documents\Chromasens\3D\sample images\two camera system 

The raw image name for the single camera system is AB_XXX.bmp, and for the dual camera 
system the two raw image names are A_XXX.bmp and B_XXX.bmp.  

 

You can find precomputed data of sample images in the following directory, which can be 
directly loaded in 3D-Viewer: (chapter 6.10.2)  
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C:\Users\Public\Documents\Chromasens\3D\sample images\single camera 
system\precomputed 

C:\Users\Public\Documents\Chromasens\3D\sample images\two camera system\precomputed 

NOTE In v2.4a or newer version, the folder of sample images and sample code are 
moved to C:\Users\Public\Documents\Chromasens\3D 

In v2.3e or older version, the folders were under C:\Program Files\Chromasens\3D 

 

6.13.3 Verify Calibration 

Each camera was exactly calibrated after being manufactured. If the environment or 
conditions are changed over time, the original calibration may not provide the same accuracy 
as before. In this case, the calibration should be checked and eventually readjusted. 

The verification process is based on detecting and matching the areas of raw images. So the 
chosen raw images should fulfil the following criterions. Otherwise the verification may not 
work successfully. 

a) The object must have a flat surface. Obvious height differences (e.g. from steps or slope) 
of the surface must be avoided.  

b) The images of the object must be sharp. 

c) Along the whole horizontal direction, the images have to be rich in recognizable textures, 
patterns or features.  

                        

Example of a suitable raw image of a metal surface used for calibration verification 

The 3D Viewer provides the possibility to check the validity of the calibration (for calibration 
version v2.0 or later). The dialog of verifying calibration can be opened by clicking the menu 
bar “Calculation” → “Verify calibration”, or by using the hotkey “ctrl+v”. 

 

 

Step 1: choose a configuration file, whose corresponding calibration file should be verified.  

By opening the “Verify Calibration” window, the current loaded configuration file will be used 
for verification by default. If a different configuration file should be used, the user can click the 
button “Load Other Config File” The file path of the chosen configuration and calibration file 
will be shown above in text field, and the corresponding camera information will be displayed 
in the middle area.  
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Step 2: choose raw image(s) which will be used for calibration verification. 

 

By default, the current loaded raw images will be directly ready for the following verification. 
The user can pick other raw images for calibration by clicking the button “Load Raw Image(s)”. 
Ideal raw images for calibration verification should have plenty of recognizable features or 
textures, which are spread regularly in the horizontal direction.  

 

Step 3: start verification 

After loading raw image(s), the verification can be started by clicking the button “Start 
Verification”. The verification will last several minutes. One of the following results will be 
shown after the verification 

a) Calibration verification is done successfully.  

The current calibration is valid. There is no need to adjust the calibration 
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b) Calibration verification is not successful. 

Most probably because the chosen image(s) are not suitable for verification due to too few 
features or texture in the raw image. The user can then choose new raw images or cancel 
the verification 

c) Calibration is not valid any more. 

This indicates that the calculation based on the calibration is not reliable. So the 
calibration should be adjusted. The user can choose to adjust and overwrite the current 
invalid calibration file or to cancel and quit the verification process. The adjustment of 
calibration will also last several minutes, In the end, a result of adjustment will be informed 
as well. 

6.13.4 Adjust Pseudo-color Map 

The user can mark an ROI by clicking and dragging the left mouse. The height information 
within this ROI will be displayed as pseudo-color map, where the blue color normally indicates 
the lower area and red the higher area of this ROI. So in most cases, the color interpretation of 
a pseudo-color map depends on the chosen ROI, namely depends on the relative height in the 
ROI. The advantage of this displaying method is that user can get an immediate clear 
impression of the height distribution of this ROI.  

 

Additionally, 3D-Viewer also provides another possibility to display pseudo-color map in a 
“global” way, which does not depend on the chosen ROI. Instead, the absolute height range 
will be used. This means, the points of the same height will always be assigned with the same 
pseudo-color regardless of how an ROI is chosen. We can open the pseudo-color map display 
wizard if we want to use this display method. 

 

There are four ways to open the pseudo-color map control wizard 

1) Use menu “View” → “Adjust pseudo-color map” 

 

2) Double click on the pseudo-color scale  

3) Right click on the pseudo-color scale to open a context menu and then click “Adjust 
pseudo-color map” 

4) Or open the menu “Calculation” → “Options” 
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By default the display of pseudo-color map does not use absolute height value but use relative 
value depending on the selected ROI, so option “Use absolute value independent on chosen 
ROI” is disabled. This option can only be enabled if a valid pseudo-color map is currently 
marked.  

After enable this option, the sliders and numeric updown boxes which indicate the displaying 
absolute height range will be enabled too. By sliding the thumbs of both sliders, or changing 
the value of distance values, the pseudo-color map will be updated. The color of pseudo-color 
map will only depend on the display range start and end. Outside this interval, it will be 
displayed as black. Even after marking different ROIs, the same area will still have the same 
pseudo-color distribution. So the visualization of pseudo-color map will not be affected by the 
chosen ROI any more, if this option is enabled.  

 

If the traditional display method (using relative height depending on ROI) should be used, you 
can disable the option “Use absolute value independent on chosen ROI” again. 

 

 

6.13.5 Comparison of Two Areas 

In 3D-Viewer, the user is able to mark two areas and then the difference of their average x,y 
and z values will be displayed. 
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How to mark two areas to compare their difference: 

1) To mark the first area, please press “ctrl”-key on the keyboard, and left click the mouse, 
then release the “ctrl”-key. The first area is marked in yellow green color and it is fixed. 

2) Move mouse to the second area, left click the mouse to mark it. Then the second area will 
be marked in royal blue color. There is a line connecting the both areas. And the 
difference of their average x, y, z values is displayed on the bottom right corner. 

3) You can just repeat step 2) to choose different second area. The new chosen area will 
always be used to compare with the first area, which is marked in step 1) 

4) To remark the first area, please repeat step 1) 

5) If you want to cancel the mark process, please press the “a”-key on the keyboard. 

 

Currently, the user can adjust the shape (square or circle) and the size of the area. This can 
be set by 

1) Opening the menu “Calculation” → “Options” →  tab “Visualization Parameters”.  

2) Or opening the menu “View” → “”Area comparison wizard” 

The x,y,z values of the pixels within the marked areas will be averaged for the comparison. 

 

 

6.13.6 Generate System Information Report 

Users are able to collect the system information, which can be related to the usage of Viewer. 
This can be realized by clicking the menu bar “Info” → “Generate system information report”. 
The following information will be generated and then saved into a log report file. 
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• Operating system 

• Total RAM and current available RAM 

• GPU Information 

• Chromasens 3D-Viewer Information (Path, existing dll files and their version, etc) 

• LabVIEW installation information 

• Camera Setup Tool (CST) installation information 

• Current camera connection (which camera is connected, camera type and id, etc) 

• Camera Link file installation information 

• HALCON installation information (root path, version, etc) 

• All windows driver file information (file path, name, date, description version, etc) 

6.13.7 License Information 

The license of 3D-Viewer is written in dongle. Its information can be retrieved by clicking the 
menu bar “Info” → “License information”  

         

The information contains: 

• License type (single or multiple license) 

• License count (the maximal allowed number of instances simultaneously)  

• Expiration date 

• Serial number of the license 

 

6.13.8 Check for Updates 

By clicking the menu bar “Info” → “Check for updates”, the program will try to connect the 
server of Chromasens and then search for the newest software version. One of the three 
messages will be shown after clicking.  

1) There is no internet connection 

2) The current version of 3D software package is up to date. 

3) There is a newer version of 3D software package. If this appears, you can decide to 
download / update the newer version or just use the current 3D-Viewer without updating. 
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7 Advanced 

7.1 Command-Line Parameters 

7.1.1 General Parameters 

--configFile [fn] Loads the configuration file [fn] at the start of the viewer  
  

--listen [port]   Listens on local-port [port] for remote control commands. See the 
separate “3DViewer Remote Control Protocol” documentation for a 
description of the protocol. 

 

--mode load [fn] [[fn2]] Loads automatically the source-image with the given filename [fn] or 
load an source image pair with the filenames [fn] and [fn2], after the 
viewer is started 

 

--mode loadAndCalc [fn] [[fn2]] Same as “--mode load” but also starts the calculation. 

 

--movingDemo [msec]  Starts to rotate the 3D-model after [msec] milliseconds of mouse- 

 inactivity. The rotation is disabled, if the mouse is placed over the 3D-
model window. 

 

--offline  Presents offline data. In offline mode, no calculation is possible, and 
no dongle is needed. It is used to avoid the “No license” error 
message 

 

7.1.2 Calculation Parameters 

The following parameters enable the possibility to set an initial value direct on startup of the viewer. 

 

--minGrayVal [intVal]  Minimum gray value used for calculation [0 … 255] 

 

--maxGrayVal [intVal]  Maximum gray value used for calculation [0 … 255] 

 

--minStdDevA [floatVal]  Minimum contrast [0.00 ... 255.00] 

 

--minKkf [floatVal]  Minimum cross-correlation factor [0.00 ... 1.00] 

 

--maxConsistent [intVal]  Max difference between with correlation from left to right and right to 
left in pixels. [0 … 100] 

 

--dStart [intVal]  Lower height range limit that is considered.  

 

--dEnd [intVal]  Upper height range limit that is considered.   

 

--windowType [intVal]  correlation window type for the calculation 
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7.2 Configuration File Properties 

The configuration file accesses information stored in the calibration file “calibration.ini”. It is 
therefore important that the directory of the calibration file is correct. 

The following illustration shows how the calibration file is accessed by the configuration file: 

 

Figure 1 - Configuration File 

Errors may occur when loading a configuration file that directs to a non-existing calibration file. 

• By saving the 3D data with the “Save calculated image-data” function (chapter 6.10), a 
configuration file is created, which directs to the calibration file created in the same folder. 

• By saving the configuration file with the “Save” and “Save as” function of the 
“Configuration window”, the configuration file will save the directory of the  calibration file 
used in the previous configuration file and always access the calibration file of the saved 
directory. 

• By saving the configuration file with the “Save current config as default” function of the 
configuration window”, a configuration file and a calibration file are created in the directory: 
C:\Users\Public\Documents\Chromasens\3D\viewer settings.  

This row indicates the location and directory of the 
calibration file. In the example left, the configuration file 
directly accesses the calibration file in the same folder. 

 

You may replace this row by: calibrationFile={directory of the 
calibration file} like in the example below..  

The configuration file then will access the calibration file in 
the specified directory. 

 

Replace to your desired directory 
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